
New Help

You have selected Help for a component that contains new Internet Explorer settings. For the latest information about the new 
things you can do with this component, click here to open Internet Explorer Help, and then search for your topic again.



What's New in Internet Explorer?

Internet Explorer is not just a browser anymore; now it enables you to integrate the Web with your desktop in 
numerous ways, and includes a set of programs that help you communicate better, including Outlook Express, 
Microsoft NetMeeting, Microsoft Chat, and FrontPage Express. 
For more information, see Internet Explorer Help.



                Context Help Starts Here:    Display Properties - Background tab



Help is available for each setting in this group. Click        at the top of the dialog box, and then click the item you want 
information about.



Shows how the selected wallpaper and pattern will look on your desktop.



Lists the available wallpapers you can use to decorate your desktop. When you click a wallpaper in this list, a preview of how the
wallpaper (and any pattern you have selected) will look appears on the monitor graphic above the list.



Click this to browse through your computer or network for the file you want to use as a background on your desktop. Your 
background wallpaper can be a picture (files with a .bmp, .jpg, .gif, or .png extension) or an HTML page.



Click this to select a pattern that you want to use on your desktop or to create a new one. If no wallpaper is selected, this pattern 
covers the entire desktop. If wallpaper is selected, this pattern fills in the space around the wallpaper to the edges of your 
screen.

If this button is not available, you have selected a setting that displays the selected wallpaper or HTML graphic across your 
entire desktop, leaving no room for a pattern to be displayed.



Determines how the selected wallpaper is displayed on your desktop. To center the image in the middle of your desktop, click 
Center. To make a repeated pattern from the image, click Tile. If this option is not available, either no wallpaper is selected or 
you have selected an HTML page to use as wallpaper on your desktop.



Specifies whether to use the Active Desktop interface. When this check box is selected, you cannot use an HTML page as 
wallpaper on your desktop or add channels or items to your desktop. 



                Pattern dialog box



Lists the available patterns you can use to decorate your desktop. When you click a pattern in this list, a preview of how the 
pattern will look on your desktop appears in the box to the right of the list.



Click this to edit the selected pattern pixel by pixel.



                  Pattern editor dialog box



Adds a newly named pattern to the list.



Saves any changes you made to the pattern. 



Removes the selected pattern from the Pattern list.    



Provides a space for you to select the pattern you want to edit or type a name for a new pattern. 



Provides a space for you to edit the selected pattern. To change the color of each pixel, click it.



Displays the results of the changes you make in the Pattern box as you edit.



                  Display Properties - Web tab



Shows how the Active Desktop items you have chosen or the channels you are currently subscribed to will appear on your 
desktop.



Lists the channels that you are currently subscribed to and the available Active Desktop items. If a check box is not selected, the 
item will not appear on the desktop.



Click this to subscribe to a new channel or add an Active Desktop item, and then follow the instructions on your screen. The new 
channel or item will be added to the list of Active Desktop items in the box on the left. 



Removes the selected channel or Active Desktop item from your desktop and from the Items on the Active Desktop list on the 
left.



Click this to change the settings for the selected channel or Active Desktop item. This button is not available if the Channel bar is
currently selected.



Opens a small window that displays the selected channel or Active Desktop item. This is useful for making sure that the address 
you specified for this channel or item is still available and opens the Web site you want.



Click this to restore all the settings in this dialog box to the ones that originally came with the program. You might want to use this
option if someone else will be using your computer who wants to subscribe to a different set of channels.



Specifies whether you want your Active Desktop to look and work like the Web. When this box is selected, you can subscribe to 
channels from your desktop, use a single-click to open items on the desktop, and add active content, such as a stock ticker, to 
your desktop. 



Click this to display the Folder Options dialog box, which contains settings for customizing the way the folders on your computer 
are displayed. 



                      Web tab - Properties button - Subscription tab



Displays the short name and the address of the selected channel, subscription, or item.



Describes the properties of the selected channel, subscription, or item. You can change these properties on the Receiving and 
Schedule tabs in this dialog box.



Click this if the selected channel, subscription, or item requires you to log in before you can open the Web site. For example, you
might have to log in to a site that has restricted access rights or one that you pay to subscribe to, such as a magazine.



Click this to cancel your subscription to the selected Web site. If this Web site is in your Favorites list, it will still be there, but the 
content will not be updated automatically.



Provides a space for you to type the user ID required for you to gain access to the selected Web site. Often, this is your e-mail 
address.



Provides a space for you to type the password required for you to gain access to the selected Web site.



Specifies whether you want Internet Explorer to notify you by e-mail whenever the contents of the selected Web site change.



Click this to choose advanced settings for how you want this site to be downloaded.



Click this to change the e-mail address that Internet Explorer uses to notify you when the contents of the selected Web site 
change. 



Provides a space for you to type the e-mail address you want Internet Explorer to use when it notifies you.



Provides a space for you to type the name of your e-mail server.    



Specifies whether you want Internet Explorer to download this Web site to your hard disk or just to notify you. If you select No, 
just notify me when the site changes, Internet Explorer changes the site’s icon as illustrated and can send you e-mail, if you 
have selected that option in the Notification area. If you select Yes, download this site, the Web content will be downloaded to
your computer at a time you specify. Then, you’ll be able to read the updated Web site offline, when you’re not connected to the 
Internet. To specify the settings for downloading the site to your computer, click Advanced.



                      Advanced Download Options dialog box



Specifies whether you want to limit the maximum amount of information, in kilobytes, that Internet Explorer downloads to your 
hard disk from this Web site. If you select this check box, you can specify an amount in the box to the right.



Specifies whether you want this Web site downloaded to your hard disk before any others are downloaded. This setting is useful 
if you want to make sure your most important Web content is always updated first on your hard disk, in case you reach the 
maximum download size specified above or run out of disk space



Specifies whether you want Internet Explorer to download graphical images when it updates the selected Web site. Graphical 
images can be slower to download and take up a large amount of space on your hard disk.



Specifies whether you want Internet Explorer to download sound and video files when it updates the selected Web site. Sound 
and video images can be slower to download and take up a large amount of space on your hard disk. 



Specifies whether you want Internet Explorer to download ActiveX Controls and Java™ applets when it updates the selected 
Web site. These are advanced, behind-the-scenes programs that enable some Web sites to display special objects. If you 
choose not to download these programs, the Web site may appear incomplete or not display properly. However, these programs 
could potentially damage your hard disk or your data.



Specifies whether you want Internet Explorer to download more than just the top-level page of the selected Web site. You can 
specify that you want to download the specified Web site up to five levels deep. For example, if you specify two levels deep, the 
first page and all the pages that it links to will be downloaded. Specifying three levels will download all the pages linked to the 
second-level pages.



Specifies whether you want Internet Explorer to download all pages that are linked to the selected Web site, up to the number of 
levels you specified in the setting above.



                    Schedule tab



Specifies that you want Internet Explorer to download the selected Web site automatically, on a schedule determined by the 
publisher of the Web site. This setting is available only if you connect to the Internet through a network. It is not available if you 
connect to the Internet by using a modem.



Specifies that you want to choose the settings for when and how often Internet Explorer downloads the selected Web site to your
hard disk. To set up a schedule for a new channel, click New. To change the settings for an existing channel, click Edit.



Specifies that you want to update the selected Web site manually. To update the selected Web site, click the Update Now 
button. You can also update one or all subscribed Web sites from the Favorites menu.



                      Custom Schedule dialog box



Provides a space for you to type a name for the custom schedule you are creating.



Specifies whether you want this Web site to be downloaded to your computer on a daily, weekly, or monthly basis.



Specifies exactly how often and when you want this Web site to be downloaded to your computer.



Specifies what time you want this Web site to be downloaded to your computer.



Specifies the times you want this Web site to be downloaded to your computer if you want that to occur repeatedly.



Specifies whether you want to allow the schedule you set to vary several minutes in its actual start time for the next update. 
Selecting this check box increases the likelihood of offsetting the demands other people may make at the same time for the 
same site and thus improve the efficiency of downloading from the Web.



                    View/ Folder Options/ Folder tab



Shows how your folder contents will look using the current settings.



Specifies that you want this folder and your desktop to look and work like a Web page. For example, when you choose this 
option, you will be able to click items on your desktop or in folders just once to open or run them, just like you click links on the 
Web. To select an item, you just point to it. Also, it enables you to add information, change font styles, and use HTML pages as 
background wallpaper.



Specifies that you want this folder and your desktop to look and work as they have in previous versions of Windows. For 
example, when you choose this option, you double-click items on the desktop or in a folder to open or run them, and click them 
once to select them.



Specifies that you want to choose your own settings to customize the way this folder and your desktop look and work. To set 
your preferences, click Settings.



Click this to choose a combination of classic Windows and Web-style settings.



            View/Folder Options/Custom Settings



Specifies whether to use the Active Desktop interface. When this check box is selected, your computer’s desktop looks and 
works like a Web page, and you can add active content to it.



Specifies that you want your desktop to look and work like a classic Windows desktop instead of like a Web page.



Click this to open the Display properties dialog box, where you can add items to the desktop if you are using the Active Desktop 
interface.



Displays the contents of each folder you open in the same window. To switch back to the previous folder, click the Back button 
on the toolbar, or press the BACKSPACE key.



Opens a new window every time you open a folder. The previous folder will still be displayed in a window, so you can switch 
between them.



Displays folders as Web pages. When a folder is displayed as a Web page, you can add information, change font styles, and use
HTML pages as background wallpaper. You cannot change the settings for My Computer and Control Panel; these folders are 
already displayed as Web pages.



Displays a folder as a Web page only when you specifically choose to do so for that folder. When a folder is displayed as a Web 
page, you can add information, change font styles, and use HTML pages as background wallpaper.



Specifies that you want to open items in folders and on the desktop by single-clicking them, just like you would click a link on a 
Web page. To select an item without opening it, you would rest your mouse pointer on it.



Specifies that you want icon titles in your folders and on the desktop to appear underlined, just like links on a Web page. For this 
to apply, you must be sure that the Underline links setting in the browser is not set to Never



Specifies that you want icon titles in your folders and on the desktop to appear underlined only when you rest your mouse pointer
on the title. 



Specifies that you want to single-click an item to select it, and double-click an item to open it. This is the traditional Microsoft 
Windows model.



              View/ Folder Options/ View tab



Click this to use the current folder settings on the View menu (except for the toolbar settings) for all folders on 
your computer.



Click this to use the folder settings on the View menu (except for the toolbar settings) that were in effect when 
this program was first installed.



Specifies that when you close a folder, the folder settings you chose are retained whenever you reopen it. When 
this box is not checked, all folders return to the state they were in when this program was installed.



Displays the path of the folder in the title bar of the window. Click this option if you want a quick way to see the 
name of the folder that is open.



Hides the three-letter file name extensions for certain files. Click this option to reduce clutter in your folder 
windows.



Shows a description of the selected folder or desktop item in a small pop-up window. When you select this 
option, the pop-up description appears even if you are not viewing the folder or your desktop as a Web page. If 
your folder is already being displayed as a Web page, selecting this option has no effect, because the same 
information already appears in the left pane of the folder.



Specifies that hidden and system files do not appear in the list of files in this folder. Select this option if you want
to protect your system files from accidentally being changed or deleted. Selecting this option also reduces 
clutter in your folder windows.



Specifies that hidden files do not appear in the list of files in this folder. Generally, hidden files are program or 
system files that should not be changed. To find out whether a file is designated as hidden, make sure this option
is not checked, right-click the file, and then click Properties. Select this option if you want to protect your hidden 
files from accidentally being changed or deleted. Selecting this option also reduces clutter in your folder 
windows. 



Specifies that all files, including hidden and system files, appear in the list of files in your folders. 



Does not display any icons on the desktop when the desktop is being viewed as a Web page. Only the taskbar 
and HTML items will be visible on the desktop.



Enables you to add buttons to the toolbar for connecting to and disconnecting from network drives. These functions are also 
available on the Tools menu.



Specifies that you want the attributes of each file, such as read only, to be displayed in a column when you are viewing the files 
in this folder in Details view.



Specifies that your computer can display a file name in all uppercase characters (such as FILENAME.TXT), if that’s the way the 
file name was originally typed. When this option is not selected, file names are changed to lowercase characters (such as 
Filename.txt), regardless of how you typed them.



Specifies that you want your computer to fill in any jagged edges in the fonts displayed on your screen. This might be useful if 
you are working with large type or with graphic design, but your computer’s performance will be slowed down.



Specifies that you want the entire contents of a window to remain visible while you are dragging that window to a different 
location. When this option is not selected, only the rectangular outline of a window is visible while you are moving it.



Restores the settings in this dialog box to the settings that originally came with this program.



          Properties for a folder (right-click on folder, Properties)



Creates thumbnail graphics of the contents of files in the selected folder, if their file formats allow.



          Toolbars, New Toolbar (right-click in taskbar)



Displays the name of the selected folder, or provides a space to type the address of the folder you want to add 
as a toolbar.



          Display properties – Screen Saver tab – Channel Screen Saver settings



Displays a list of channels currently set up to appear as channel screen savers. To add a channel to this list, just click Yes when 
the Channel Subscription wizard asks whether you want to include this channel in the Channel Screen Saver.



Specifies how long you want each channel to display its screen saver before switching to the next channel.



Specifies whether you want to hear the sounds associated with each channel screen saver. This setting works only if you have a 
sound card and speakers installed on your computer.



Specifies whether you want to move your mouse pointer to close the Channel Screen Saver, or click the Close button in the 
upper-right corner of the window. 



Click this to create a new custom schedule.



Deletes the selected custom schedule. If this schedule is also used by other subscriptions, the other subscriptions will no longer 
update automatically. 



            View\Folder Options menu, Files Types tab, Add New File Type dialog box



Provides a space for you to type or select the type of file you are adding. MIME stands for Multipurpose Internet 
Mail Extensions; it is a protocol for defining file attachments for the Web.



Provides a space for you to type or select the extension that is associated with this file type—for example, the 
standard extension for text files is .txt.



Specifies that you always want to open files of this type as soon as they have finished downloading.



Specifies that you always want files of this type to open in the existing window instead of creating a new window.



           View\Folder Options menu, File Types tab



Displays the three-letter extension currently associated with this file type—for example, the standard extension 
for text files is .txt.



Displays the program that is currently selected to open files of this type. If you want to change this program, 
select the file type you want to change it for, click Edit, click Open, and then click Edit again.



 




